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SAFETY MESSAGES Procedures and instructions in this section may require special precautions to
ensure the safety of the personnel performing the operations. Information that

raises potential safety issues is indicated by a warning symbol (A ). Please
refer to the following safety messages before performing an operation
preceded by this symbol.

Failure to follow safe installation and service guidelines could result in death or
serious injury

« Make sure the transmitter is installed by qualified personnel and in accordance
with applicable code of practice.

« Use the equipment only as specified in the Rosemount 5300 Series Reference
Manual (Document No. 00809-0100-4530), the Rosemount 5400 Series
Reference Manual (Document No. 00809-0100-4026), and in this Manual
Supplement. Failure to do so may impair the protection provided by the
equipment.

« Do not perform any services other than those contained in this manual unless
you are qualified.
Explosions could result in death or serious injury

« Verify that the operating environment of the transmitter is consistent with the
appropriate hazardous locations specifications.

« To prevent ignition of flammable or combustible atmospheres, disconnect
power before servicing.

« Before connecting a HART® or FOUNDATION™ fieldbus based communicator in
an explosive atmosphere, make sure the instruments in the loop are installed in
accordance with intrinsically safe or non-incendive field wiring practices.

« To avoid process leaks, only use o-ring designed to seal with the
corresponding flange adapter.

Electrical shock can result in death or serious injury

« Avoid contact with the leads and terminals. High voltage that may be present
on leads can cause electrical shock.

* Make sure the main power to the Rosemount 5300 Series transmitter or
Rosemount 5400 Series transmitter is off and the lines to any other external
power source are disconnected or not powered while wiring the transmitter.

Probes with non-conducting surfaces

* Probes covered with plastic and/or with plastic discs may generate an
ignition-capable level of electrostatic charge under certain extreme conditions.
Therefore, when the probe is used in a potentially explosive atmosphere,
appropriate measures must be taken to prevent electrostatic discharge.

1-2
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INTRODUCTION

Figure 1-1. System Overview

The Rosemount 5300 Series and Rosemount 5400 Series transmitters are
Modbus compatible measurement devices that support communication with a
Remote Terminal Unit (RTU) using a subset of read, write, and diagnostic
commands used by most Modbus compatible host controllers. The
transmitters also support communication through Levelmaster and Modbus
ASCII protocols.

The HART® to Modbus Converter (HMC) module is located inside the
Rosemount 5300 and Rosemount 5400 transmitter enclosure and provides
power to and communicates with the transmitter through a HART interface.

5300/5400 transmitter enclosure

WORKFLOW

| Modbus and
Levelmaster
I communication Remote
- > Terminal
I Unit
HART |
5300/5400 signals HART to I
transmitter | <g————————— Modbus |
electronics Converter I
|
I HART signals Rosemount
< p-| Radar Master/
Field
| Communicator
___________________ -

During normal operation, the HMC “mirrors” the contents of process variables
from the 5300/5400 transmitter to the Modbus registers. To configure the
5300/5400 transmitter, it is possible to connect a configuration tool to the
HMC. See “Transmitter Configuration” on page 1-13 for more information.

Overview of workflow for commissioning a Rosemount 5300 or a Rosemount
5400 transmitter with Modbus protocol:

1. Mount the transmitter on the tank.

2. Connect the power and communication wires.

3. Establish HART communication with the transmitter through Rosemount
Radar Master, or a Field Communicator. This is done by:

» Connecting to the HART terminals, or
» Connecting to the MA/MB terminals (tunneling mode)
4. Configure the transmitter.
5. Configure the Modbus communication.
6. Configure Modbus host.
7. Verify output values as reported by the transmitter.

1-3
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MECHANICAL
INSTALLATION

ELECTRICAL
INSTALLATION
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For instructions on how to mount the Rosemount 5300/5400 transmitter, refer
to the Rosemount 5300 Series Reference Manual (Document No.
00809-0100-4530), and the Rosemount 5400 Series Reference Manual
(Document No. 00809-0100-4026).

NOTE

For general electrical installation requirements, including grounding
requirements, refer to Rosemount 5300 Series Reference Manual (Document
No. 00809-0100-4530), and the Rosemount 5400 Series Reference Manual
(Document No. 00809-0100-4026).

To connect the Rosemount 5300/5400:

A 1.

Disconnect/shut off the electrical power to transmitter head and then
open the instrument cover. Do not remove the cover in an explosive
atmosphere with a live circuit.

Pull the cable through the cable gland/conduit. For the RS-485 bus, use
shielded twisted pair wiring, preferably with an impedance of 120Q
(typically 24 AWG) in order to comply with the EIA-485 standard and
EMC regulations. The maximum cable length is 4000 /1200 m.

Make sure that the transmitter housing is grounded, then connect wires
according to Figure 1-2 and Table 1-1. Connect the lead that originates
from the “A” line from the RS-485 bus to the terminal marked MB, and
the lead that originates from the “B” line to the terminal marked MA.

If it is the last transmitter on the bus, connect the 120Q termination resistor.

Connect the leads from the positive side of the power supply to the
terminal marked POWER +, and the leads from the negative side of the
power supply to the terminal marked POWER -. The power supply
cables must be suitable for the supply voltage and ambient temperature,
and approved for use in hazardous areas, where applicable.

Attach and tighten the housing cover. Tighten the cable gland, then plug
and seal any unused terminals, and connect the power supply.
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Figure 1-2. Field Wiring Connections
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Connection Terminals The connection terminals are described in Table 1-1 below:

Table 1-1. Connection Terminals

Connector label Description Comment
HART + Positive HART connector Connect to PC with RRM
software, Field
HART - Negative HART connector Communicator, or other

HART configurators.

Modbus RS-485 B connection

MA (RXITXH)W
- Connect to RTU
MB Modbus RS-485 A connection
(RXITX-)®
POWER + Positive Power input terminal | Apply +8 Vdc to +30 Vdc
POWER - Negative Power input terminal | (Max. rating)

(1) The designation of the connectors do not follow the EIA-485 standard, which states
that RX/TX- should be referred to as 'A' and RX/TX+ as 'B'.

Figure 1-3. Connection Terminals
for Rosemount 5300/5400 with
HART to Modbus Converter

ROSEMOUNT

HART to Modbus Converter

HART - - '\
HART Ambients > 60 °C
Use wiring rated
HART + +-J for min 90 °C
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RS-485 Bus

Installation cases

The 5300/5400 transmitters do not provide electrical isolation between
the RS-485 bus and the transmitter power supply
Maintain a bus topology and minimize stub length
Figure 1-4 identifies multidrop wiring topology, where up to 32 devices

may be wired on one RS-485 bus
The RS-485 bus needs to be terminated once at each end, but should

not be terminated elsewhere on the bus

Install the Rosemount 5300/5400 Series Transmitters as shown in Figure 1-4.

Use common ground for Modbus Master and Power Supply
The Power cables and RS-485 Bus are in the same cable installation

An ground cable is installed and shall be used (cable size 24 mm
according to IEC60079-14, or size according to applicable national

regulations and standards). A properly installed threaded conduit
connection may provide sufficient ground.

The cable shielding is grounded at master site (optional)

NOTE

A

The HMC equipped transmitter contains intrinsically safe circuits that require
the housing to be grounded in accordance with national and local electrical
codes. Failure to do so may impair the protection provided by the equipment.

Figure 1-4. Multidrop Connection of

5300/5400 Transmitters
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:::::::
Internal Internal
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External
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Alternatively, the Rosemount 5300/5400 Series Transmitters can be installed
as shown in Figure 1-5. If this wiring layout is used, there is an increased risk
for communication disturbances due to differences in potential between
grounding points. By using the same grounding point for Modbus Master and
Power Supply, this risk is reduced.

Figure 1-5. Alternative Multidrop
Connection of 5300/5400
Transmitters

B Modbus
120Q = RS-485 Bus > A Master

Internal Internal
Ground Screw Ground Screw
fany s
D D
J_ External J_ External
= Ground Screw = Ground Screw
+ Power
Supply

i

Star Topology

For a Star Topology Connection of the 5300/5400 transmitters, the transmitter
with the longest cable run needs to be fitted with a 120-Q termination resistor.

Figure 1-6. Star Topology
Connection of 5300/5400
Transmitters
CoTTTTT + For Star Topology
— connection,
connect the 120Q
termination
resistor to the
transmitter with
the longest cable
run.

1-8



Manual Supplement
00809-0500-4530, Rev AA
October 2010

Rosemount 5300/5400 Series

External HART Devices
(Slaves)

Table 1-2. Approximate update
rates for measurement values

Figure 1-7. The HMC Module
supports up to four external devices
(slaves)

Up to four
external
devices

The HMC supports up to four external HART devices. The external devices
are separated by using the HART address. The address must be different
between the external devices and only addresses 1 to 5 are allowed for
multiple slaves. Connect the devices one at a time and change the short
address prior to connecting the next device by using a HART Configuration
Tool such as RRM, or a Field Communicator.

NOTE

The power supply from the HMC to external HART devices is not intrinsically
safe. In a hazardous environment, any external HART device connected to
the HMC must have Flameproof/Explosion-proof certification.

The HMC cyclically polls the HART devices for measurement values. The
update rate depends on the number of connected devices and is shown in
Table 1-2.

No. of devices

(slaves) Approx. update rate

2 seconds
3 seconds
4 seconds
5 seconds
5 seconds

A | W N -

RS-485 Power
Bus Supply

------ External HART External HART
device 2 device 1
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ESTABLISH HART
COMMUNICATION

Connect to the MA/MB
terminals

Figure 1-8. RS-485 Communication
after startup

1-10

The Rosemount 5300 Series and Rosemount 5400 Series can be configured
using the Rosemount Radar Master (RRM) PC software or a Field
Communicator. Configuration is done by sending HART commands through
the HART to Modbus Converter (HMC) to the 5300/5400 transmitter
electronics. To establish HART communication, connect to the MA/MB
terminals, or to the HART terminals. Both alternatives are described below.

The 5300/5400 level transmitter can be configured with RRM using the MA,
MB terminals.
An RS-485 Converter is required to connect to the transmitter.

The transmitter will try to establish communication using different protocols
during 20 second timeslots from time of startup.

Configured Configured
protocol protocol
Modbus RTU | HART (Modbus RTU, HART (Modbus RTU,
20 seconds |20 seconds | Levelmaster, | 50 seconds | Levelmaster,
or Modbus or Modbus
ASCII) ASCII) .
20 seconds 20 seconds | Time
Os 20s 40 s 60 s 80s 100 s

The transmitter will continue to use a communication protocol once
communication has been established.
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To configure the 5300/5400 level transmitter using RRM and the MA, MB
terminals, do the following:

1. Connect the RS-485 Converter to the MA, MB connectors.
2. Start RRM and open Communication Preferences.

3. Enable HART communication and make sure the port for the RS-485
Converter is selected. Use the following settings:

Communication Preferences

%]
]
Modbus T HART I Foundation Fieldbus

| Enable HART Communication
<< Basic |
— Port Setting:
Fart
IEDM‘I [Communications Port] LI
Modem
IHS-232 vl
— Advanced
Baudrate Handshake
{1200 -l |RTS/CTS -l
Stop Bitz Fesponze Timeout
I1 [~ f1000 s
Parity Fietries
|0dd -l E
Preambles Master Mode
|5 ISecondary LI
Max HART Query Length [bytes)
Fiobust High Speed
] 195
5 195
QK | Cancel | Apply | Help |

4. Connect the power wires (or cycle power) to the transmitter.

5. Wait 20 seconds and then open the Search Device window in RRM (also
see note below). Make sure HART address 1 is being scanned.

4, Search Device 52

Protocols] [[aRT [coMe] =l | getings.. | «Basic |

—Select Scan Type
" Sean All Addresses
{* Scan Address Range
| 0 o | 1
(" Scanby Tag

—

~ Select Device

I [Maime | Device Type | “ersion Protocaol Address Unit ICr

Start Scan Stop Scan (]9 Cancel

Scanning HART Address: 0 .. |

111
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terminals
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6. Connect to the transmitter and perform the necessary configuration.

7. After completing the configuration, disconnect the RS-485 Converter,
connect the Modbus communication wires and cycle power to the
transmitter

8. Verify communication between the transmitter and the RTU is
established (can take up to 60 seconds from startup).

NOTE

Take the following into consideration if there are multiple 5300/5400 Modbus
units on the bus:

By default, the transmitters have HART address 1. It will not be possible to
establish communication on HART address 1 if several transmitters have the
same address. In this case, there are alternative solutions to establish
communication:

1. Selectthe Scan by Tag option in the Search Device window in RRM and
enter the HART Device Tag of the transmitter. Communication can now
be established with an individual transmitter even if several devices have
the same HART address.

4, Search Device
Protocalls] ’W‘ Settings... << Basio |
Select Scan Type

™ Scan All Addresses

" Scan Address Range
I

* ScanbyTag
o

Select Device

|Name |Devica Type |Vars\nn Protacol Address Unit ID

282 HART

Start Scan akK | Cancel | Help i

Scan aborted. 1 device(s) found Select device and press Ok to connect.

2. Make sure the 5300/5400 transmitter is alone on bus. Disconnect or turn
off power from any other devices.

To configure the 5300/5400 transmitter, connect the communicator or PC to
the HART terminals using a HART modem, see Figure 1-3 on page 1-6. Both
the configuration tool and the RS-485 bus can be connected simultaneously.
Configuration data is sent with HART commands through the HMC to the
5300/5400 transmitter electronics, as illustrated in Figure 1-1 on page 1-3.
Note that the power supply must be connected during configuration, see also
“Electrical Installation” on page 1-4.

NOTE
Measurement data is not updated to the Modbus Master when a configuration
tool is connected.
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TRANSMITTER
CONFIGURATION

Configuration data such as Tank Height, Upper Null Zone, dielectric
constants, and other basic parameters are configured in the same way as for
a standard Rosemount 5300/5400 transmitter. For more information, see the
Rosemount 5300 Series Quick Installation Guide (Document No.
00825-0100-4530), and the Rosemount 5400 Series Quick Installation Guide
(Document No. 00825-0100-4026).

Make sure that the measurement unit of the Primary Variable (PV) matches
the configuration of the Modbus Host since the transmitter output value does
not include any information on associated measurement units.

For further information on basic configuration, see the Rosemount 5300
Series Reference Manual (Document No. 00809-0100-4530), and the
Rosemount 5400 Series Reference Manual (Document No.
00809-0100-4026).

NOTE

The 5300/5400 transmitter with Modbus protocol is configured to HART
address 1 at factory. This reduces power consumption by locking the analog
output at 4 mA.

113
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MODBUS
COMMUNICATION
PROTOCOL
CONFIGURATION

Table 1-3. List of RTUs’ Supported

Protocols

Using RRM to change
communication
parameters
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The Rosemount 5300/5400 level transmitter can communicate with RTUs
using Modbus RTU (often referred to as just “Modbus”), Modbus ASCII, and
Levelmaster (also known as “ROS,” “Siemens,” or “Tank” protocol).

RTU Protocols
ABB Totalflow Modbus RTU, Levelmaster
Bristol ControlWave Micro Modbus RTU

Emerson Process Modbus RTU, Levelmaster®

Management ROC800 Series
Emerson Process
Management FloBoss 107
Kimray DACC 2000/3000
ScadaPack Modbus RTU

Thermo Electron Autopilot Modbus RTU, Levelmaster

(1) Levelmaster protocol should be used when using the Emerson
Process Management Digital Level Sensor (DLS) User Program
or Application Module together with the device. Use Modbus
RTU in other cases.

Modbus RTU, Levelmaster®

Levelmaster

Modbus ASCII is not commonly used, since it doubles the amount of bytes
for the same message as the Modbus RTU.

If you do not have any of these RTUs, check your RTU manual to see which
protocols it supports.

NOTE
To change Modbus communication parameters, the Rosemount 5300/5400
must use HART address 1, the default address.

NOTE

After changing communication parameters, disconnect the HART modem and
wait at least 60 seconds for the change to take effect.

In case the MA/MB terminals are used for connection to the HMC, disconnect
the RS-485 Converter, cycle power to the transmitter and wait up to 60
seconds for the change to take effect.
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To change the Modbus address and communication parameters in
Rosemount Radar Master (RRM):

1. Start RRM and connect to the transmitter.
2. In RRM, select Setup>General.

General - [LT-01] =&
C ication | DeviceTag | Urits 1 LD
Protocal
HART Setiings .| Modbus Setup. | Modbus Setup
Part
COME
Burst Mode
Device Address Burst Mode Cmd Mumber
! o P -

Enable Burst Mode

Fiead | Cloze Help

3. Select the Communication tab.
4. Click the Modbus Setup button.

5] Modbus Setup

The Modbus Setup window lete you configure Modbus communication
parameters to match the communication settings of the connected host.

{* ‘Enter Modbus communication settings

Morhus Protocol — [Madbus RTU =
tcldress 246

Baud Rate |3600 |
Data Bits [ =l
Parity [None ~|
Stap Bits [ne |

" Enter uzer defined communication settings string [advanced)

Modbus String ‘

Ok | Cancel ‘ Help |

5. In the Modbus Setup window, select Modbus protocol and type the
desired Modbus address.

6. Enter the baud rate, parity, and stop bits, then click the OK button.

It is also possible to enter a user-defined Modbus Message in the Modbus
String area.

See separate sections below for more details regarding each Modbus
protocol.

1-15
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Using a Field
Communicator to change
communication
parameters

Modbus RTU
Communication Setup

Table 1-4. Modbus RTU
Communication Parameters

Table 1-5. Communication
Parameters Used by the Host
(example)

1-16

NOTE
To change Modbus communication parameters, the Rosemount 5300/5400
must use HART address 1, the default address.

NOTE
After changing communication parameters, disconnect the Field
Communicator and wait up to 60 seconds for the change to take effect.

The Modbus communication parameters can be changed by entering a text
string in the HART Message parameter. See separate sections below for
details regarding each Modbus protocol and what strings to use.

When using the Field Communicator, the Message Area is reached using
HART command [2,2,1], and then selecting Message (menu item 11 for
Rosemount 5300 and menu item 10 for Rosemount 5400).

The Rosemount 5300/5400 is configured with the default Modbus RTU
address 246, and with the following Modbus RTU communication parameter
default settings:

Parameter | Default Value Configurable Values
Baud Rate | 9600 1200, 2400, 4800, 9600, 19200
Start Bits® | One One
Data Bits®” | Eight Eight
Parity None None, Odd, Even
Stop Bits One One or Two
gdrgzss 246 1-255

(1) Start Bits and Data Bits cannot be changed.

To reset the communication parameters to default Modbus RTU settings, use
the following Modbus Message:

HMC

Modbus RTU Parameter Configuration Example

You want to use address 44 for the 5300/5400 transmitter, and the following
communication parameters are used by the host:

Parameter Value
Baud Rate 4800
Start Bits One
Data Bits Eight
Parity Odd
Stop Bits Two
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Levelmaster
Communication Setup

Table 1-6. Levelmaster
Communication Parameters

To configure the 5300/5400 transmitter to communicate with the Host in this
example, the following text string is written to the HART Slave 1 Message
Area:

HMC A44 B4800 PO S2.

HMC: These three letters are used for safety and will eliminate the risk of
changing the configuration data by mistake.

A44: A indicates that the following number is the new address (address 44).
Leading zeroes are not needed.

B4800: B indicates that the following number is the new baud rate (1200,
2400, 4800, 9600, 19200).

PO: P identifies the following letter as parity type (O = odd, E = even, and
N = none).

S2: S indicates that the following figure is the number of stop bits (1 = one,
2 = two).

Only values that differ from the current values need to be included. For
example, if only the address is changed, the following text string is written into
the 5300/5400 (HART Slave 1) Message Area:

HMC A127,

indicates that 127 is the new address.

The default and configurable parameter values can be found in Table 1-6.

Parameter Default value Configurable value
Baud Rate 9600 1200, 2400, 4800, 9600, 19200
Start Bits One One
Data Bits Seven Seven, Eight
Parity None None, Odd, Even
Stop Bits One One or Two
Address 1 1-99

To reset the communication parameters to default Levelmaster settings, use
the following Modbus Message:

HMC M2
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Levelmaster Parameter Configuration Example

You want to use address 2 for the 5300/5400 transmitter and the host uses
the following parameters:

Table 1-7. Parameters Used by the

Host (in case of Levelmaster, PRrEmEEr Value
example)
Baud Rate 9600
Start Bits One
Data Bits Seven
Parity None
Stop Bits One

To configure the 5300/5400 transmitter to communicate with the Host in this
example, the following text string is written to the Modbus Message area.

HMC M2 A2 B9600 D7 PN S1.

NOTE
Include all the parameters when writing to the message area.

Note that an address must be unique on the bus.

HMC: These three letters are used for safety and will eliminate the risk of
changing the configuration data by mistake.

M2: This means that the Levelmaster protocol is to be used.

A2: A indicates that the following is the new address (address 2). Leading
zeroes are not needed.

B9600: B indicates that the following number is the new baud rate (1200,
2400, 4800, 9600, 19200).

D7: D indicates that the following data bits are to be used (7 = seven,

8 = eight).
PN: P identifies the following letter as parity type (O = odd, E = even, and
N = none).

S1: S indicates that the following figure is the number of stop bits (1 = one,
2 = two).

Note: Start Bits are not configurable and cannot be set.

1-18
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Table 1-8. Implemented Functions
of Levelmaster Protocol

Table 1-9. Letters and Expressions
Used in Previous Tables

In Table 1-8 and Table 1-9 is a description of the implemented functions of
Levelmaster protocol in the HMC.

Input format Description Output format
unnN? Return ID number UnnNnnCcccc
UnnNmm Set ID number UnnNOKCcccc

unnkF? Return number of floats UnnFxCcccc

unnFx? Set number of floats UnnFOKCcccc

unn? Return floats and other data \Lfvmgiggﬂ)ﬁ Eeeee

(1) Inthis case, number of floats is set to 1. If number of floats is set to 2, the Output Format
would be: UnnDddd.ddDddd.ddFfffEeeeeWwwwCcccc

NOTE
If one float is sent, it is “Float1”. If two floats are sent, it is “Float 1” before
“Float 0”.
Letter Description
nn is used to identify slave to respond,
an nn is a number 00-99 or ** (wildcard).
The EmulCtrl Address Holding register can be configured to a higher
value than 99. In that case, the address will be truncated to 99.
mm mm is the new ID number for the slave; mm is a number 00-99.
« X is the number of floats returned when slave receives Unn?, x is a
number 0-2.
ccee Is the 16 bit CRC checksum, cccc are hexadecimal characters.
ddd.dd ddd.dd is the distance value from slave 1. Note that the first d can also be
' a ‘-’ (minus).
Float1 | Slave 1 PV.
Float0 | Slave 1 SV.
fff The temperature value. Configured by Holding Register 3208 in HMC.®
An error value.
ceece Bit 0: Invalid SV value (Float 0).
Bit 8: Invalid Temperature value.
Bit 12: Invalid PV value (Float 1).
Wwww | A warning value, not used in this implementation.

(1) Any of the four available variables from any of the five HART slaves can be selected as
the temperature source.
The least four significant bits (bit 0-3) select the variable number. Bits 4-7 select the HART
slave address. If invalid values are used, the temperature value will be invalid, with no
Error bit set.
For example, if we want to use FV from HART Slave 3 as temperature source, we have
to write the value 34 Hex (52 decimal).
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Modbus ASCII
Communication Setup

Table 1-10. Modbus ASCII
Communication Parameters

Table 1-11. Parameters Used by
the Host (in case of Modbus ASCII,
example)
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The parameter, default, and configurable values are shown in Table 1-10

below.

Parameter Default value Configurable values
Baud Rate | 9600 1200, 2400, 4800, 9600, 19200
Start Bits One One
Data Bits Seven Seven, Eight
Parity None None, Odd, even
Stop Bits One One or Two
Address 1 1-255

To reset the communication parameters to default Modbus ASCII settings,
use the following Modbus Message:

HMC M1

Modbus ASCII Parameter Configuration Example

You want to use address 246 for the 5300/5400 transmitter and the host uses
the following parameters:

Parameter Value
Baud Rate 9600
Start Bits One
Data Bits Seven
Parity None
Stop Bits One

To configure the 5300/5400 transmitter to communicate with the Host in this
example, the following text string is written to the Modbus Message area.

HMC M1 A246 B9600 D7 PN S1.

NOTE
Include all the parameters when writing to the message area.

Note that an address must be unique on the bus.

HMC: These three letters are used for safety and will eliminate the risk of
changing the configuration data by mistake.

M1: This means that the Modbus ASCII protocol is to be used.

A246: A indicates that the following number is the new address (address
246). Leading zeroes are not needed.

B9600: B indicates that the following number is the new baud rate (1200,
2400, 4800, 9600, 19200).
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D7: D indicates that the following data bits are to be used (7 = seven,
8 = eight).

PN: P identifies the following letter as parity type (O = odd, E = even, and
N = none).

S1: S indicates that the following figure is the number of stop bits (1 = one,
2 = two).

Note: Start Bits are not configurable and cannot be set.
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NOTE

If the Modbus communication setup has been changed, but the transmitter
has not yet started to use the new configuration, then you need to disconnect
the HART modem and wait up to 60 seconds for the change to take effect.

In case the MA/MB terminals are used for connection to the HMC, disconnect
the RS-485 Converter, cycle power to the transmitter and wait up to 60
seconds for the change to take effect.

The Modbus communication settings will otherwise be lost if you write a new
message to the transmitter.

The output from the Modbus transmitter in case of an error (such as a field
device malfunction) can be configured. The values for Modbus registers
corresponding to PV, SV, TV, and QV will be changed accordingly (applicable
registers in area 1300, 2000, 2100, and 2200).

The default alarm output value for each protocol is defined on the next page.
Configuring alarm output value is optional.

Use the Modbus string to configure the alarm output. To enter a Modbus string
in RRM, do the following (Modbus RTU shown):

1. Start RRM and connect to the transmitter.
2. In RRM, select Setup>General.

General - [LT-01] =&
C ication | DeviceTag | Urits 1 LD
Protocal
HART Settings... | Modbus Setup...| Modbus Setup
Part
COME
Burst Mode
Device Address Burst Mode Cmd Mumber
! o P -

Enable Burst Mode

Fiead Cloze Help
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3. Select the Communication tab.
4. Click the Modbus Setup button.

Modbus Setup
The Modbus Setup window let: you configure Modbus communication
parameters to match the communication settings of the connected host.

" Enter Modbus communication setings
Modbus Protocol | J
Address |
Baud Rate | J
Data Bits | J
Parity | J
Stop Bits | J
///\
% Enter uzer defined communication settings sting [advanced)
< Modbus String |HMC EU u-939 >
0K | Cancel | Help |

5. Enter the Modbus string, and click OK.
See below for available Alarm Output Modbus strings.

Modbus RTU

String Alarm Output

HMC EN Not a number (NaN), default

HMC EF Freeze, hold last value

HMC EU U-0.1 User defined value, -0.1 in this example

Levelmaster

String Alarm Output

HMC M2 EH High value, 999.99, default
HMC M2 EL Low value, -99.99

HMC M2 EF Freeze, hold last value

HMC M2 EU UO

User defined value (range -99.99 to 999.99),
0 in this example

Modbus ASCII

String Alarm Output

HMC M1 EN Not a number (NaN), default
HMC M1 EF Freeze, hold last value

HMC M1 EU U-0.1

User defined value (range -99.99 to 999.99),
-0.1 in this example

NOTE

After changing the Alarm Output configuration, disconnect the HART modem
and wait up to 60 seconds for the change to take effect.

In case the MA/MB terminals are used for connection to the HMC, disconnect
the RS-485 Converter, cycle power to the transmitter, and wait up to 60
seconds for the change to take effect.
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Verify Alarm Output

Use status information to
evaluate measurement
validity

Use Heartbeat to detect
errors

1-24

To verify the Alarm Output, use RRM to simulate a device failure:

1. Establish HART communication with the transmitter through RRM.
2. Select Simulation Mode in the Tools menu.

Simulation Mode - [LT-01]
4 WARNING Simulation Yalues
Device Communication Hazard DiEre (] Start
0,000 m
Druring simulation the output from .
the device will not be controlled by | | [T Enable Measurement Alarm [simulated]

the device measurement.
Make sure spstems and people
relying on data from the device are

v Enable Device Failure Alarm [simulated]

made_ awars of the ch@nged_ . Status: Live Values. Ho Simulation.
c:_ondltl_ons when entering/exiting
simlation mode. Wiew live/simulated values

Failure to do so could result in . .
death, serious injury and/or Frezz button to open Device Display

property damage

Cloze | Help

Click Enable Device Failure Alarm (simulated).

Click the Start button.

Disconnect HART modem.

Verify that the configured alarm output is available in the Modbus host.

No ok ow

Use RRM to turn off simulation mode.

The transmitter updates status information about the current measurement,
and this status information is available as a bitfield register through Modbus
communication.

By monitoring the status information it is possible to determine if the current
measurement output value is valid. See “Common Modbus Host
Configuration” on page 1-25 for details about the individual status bits.

By reading and evaluating the Heartbeat value from the device, it is possible
to verify that the communication link between the transmitter, HMC, RTU and
even the control system communicating with the RTU is working.

Assign Heartbeat to one of the transmitter variables (SV, TV, or QV).
Heartbeat is increased by one for each measurement cycle in the device (until
it eventually starts over at zero again).

In case this value is not updated, it means that the communication link is
broken.
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COMMON MODBUS
HOST CONFIGURATION

Table 1-12. Byte Transmission
Order is specified by the Floating
Point Format Code

Input Registers

When using Modbus RTU or Modbus ASCII, the registers to receive status
and variables must be configured in the host system.

The transmission of single-precision (4 bytes) IEEE 754 floating point
numbers can be rearranged in different byte orders specified by the Floating
Point Format Code. The format code information, stated for each Remote
Terminal Unit (RTU) respectively, specifies which registers to poll from the
5300/5400 transmitter in order for the RTU to correctly interpret floating point
numbers. The byte transmission order for each format code is demonstrated
in Table 1-12 below.

Format Byte transmission Description
Code order
0 [AB] [CD] Straight word order, most significant byte first
1 [CD] [AB] Inverse word order, most significant byte first
2 [DC] [BA] Inverse word order, least significant byte first
3 [BA] [DC] Straight word order, least significant byte first
NOTE

Some Modbus hosts cannot read the information described here using Input
Registers (Modbus function code 4). The Input Register information can also
be read using Holding Register (Function code 3). In this case, Input Register
number + 5000 is used as Holding Register number.

Between host system and device, it is recommended to use 60 seconds or
less between polls, and three retries.

The register area starting with 1300 can be configured to have any of the four
format codes. The configuration is done by setting FloatingPointFormatCode
register (holding register 3000) to 0-3, as shown in Table 1-12. This
configuration can be done with the Rosemount Radar Master program.

NOTE

Depending on the slave number the 5300/5400 transmitter is using, different
registers must be used with the default slave number being 1. Slave number
is determined by the HART address.
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Table 1-13. Output Variables for the
Configurable Floating Point Format
(default code 1)

1-26

Register

Number Note

Register Name

Bit information in bitfield.

Bit O: Invalid Measurement Slave 1 PV.

Bit 1: Invalid Measurement Slave 1 Non PV.

Bit 2: Invalid Measurement Slave 1 Non PV.

Bit 3: Invalid Measurement Slave 1 Non PV.

Slave 1 Status Bit 14: HART bus busy (slave in burst or other
1300

Conf master present)

Bit 15: HTM Task not running (option not

available).

Note: Bit 1-3 is set when Invalid Measurement of

Slave 1 Non PV. i.e. all three bits are set

simultaneously.

Primary variable from slave 1 represented in
Slave 1 PV Conf 1302 IEEE 754 format, using the byte order set in the
FloatingPointFormatCode register.

Secondary variable from slave 1 represented in
Slave 1 SV Conf 1304 IEEE 754 format, using the byte order set in the
FloatingPointFormatCode register.

Tertiary variable from slave 1 represented in
Slave 1 TV Conf 1306 IEEE 754 format, using the byte order set in the
FloatingPointFormatCode register.

Fourth variable from slave 1 represented in IEEE

Slave 1 FV Conf 1308 754 format, using the byte order set in the
FloatingPointFormatCode register.

Slave 2 data 1310-1318 | Same data as for Slave 1.

Slave 3 data 1320-1328 | Same data as for Slave 1.

Slave 4 data 1330-1338 | Same data as for Slave 1.

Slave 5 data 1340-1348 | Same data as for Slave 1.

The Rosemount 5300/5400 register area starting with register 2000 is used
for hosts that require Floating Point Format Code 0 (see Table 1-14).

Floating Point Format Codes 2 and 3 use register areas 2100 and 2200,
respectively (see Table 1-15 and Table 1-16).
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Table 1-14. Output Variables for
Floating Point Format Code 0

Table 1-15. Output Variables for
Floating Point Format Code 2

Register Name

Register Number

Note

Slave 1 Status

2000

Bit information in bitfield:

Bit 0: Invalid Measurement Slave 1 PV.
Bit 1: Invalid Measurement Slave 1 SV.
Bit 2: Invalid Measurement Slave 1 TV.
Bit 3: Invalid Measurement Slave 1 FV.
Bit 14: HART bus busy (slave in burst or
other master present)

Bit 15: HTM Task not running (option not
available).

Note: Bit 1-3 is set when Invalid
Measurement of Slave 1 Non PV, i.e. all
three bits are set simultaneously.

Slave 1 PV

2002

Primary variable from slave 1
represented in IEEE 754 format, using
Floating Point Format Code 0.

Slave 1 SV

2004

Secondary variable from slave 1
represented in IEEE 754 format, using
Floating Point Format Code 0.

Slave 1 TV

2006

Tertiary variable from slave 1
represented in IEEE 754 format, using
Floating Point Format Code 0.

Slave 1 FV (QV)

2008

Fourth variable from slave 1 represented
in IEEE 754 format, using Floating Point
Format Code 0.

Register Name

Register Number

Note

Slave 1 Status

2100

Bit information in bitfield:

Bit O: Invalid Measurement Slave 1 PV.
Bit 1: Invalid Measurement Slave 1 SV.
Bit 2: Invalid Measurement Slave 1 TV.
Bit 3: Invalid Measurement Slave 1 FV.
Bit 14: HART bus busy (slave in burst or
other master present)

Bit 15: HTM Task not running (option not
available).

Note: Bit 1-3 is set when Invalid
Measurement of Slave 1 Non PV, i.e. all
three bits are set simultaneously.

Slave 1 PV

2102

Primary variable from slave 1
represented in IEEE 754 format, using
Floating Point Format Code 2.
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Table 1-16. Output Variables for
Floating Point Format Code 3
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Register Name

Register Number

Note

Slave 1 SV

2104

Secondary variable from slave 1
represented in IEEE 754 format, using
Floating Point Format Code 2.

Slave 1 TV

2106

Tertiary variable from slave 1
represented in IEEE 754 format, using
Floating Point Format Code 2.

Slave 1 FV (QV)

2108

Fourth variable from slave 1 represented
in IEEE 754 format, using Floating Point
Format Code 2.

Register Name

Register Number

Note

Slave 1 Status

2200

Bit information in bitfield:

Bit O: Invalid Measurement Slave 1 PV.
Bit 1: Invalid Measurement Slave 1 SV.
Bit 2: Invalid Measurement Slave 1 TV.
Bit 3: Invalid Measurement Slave 1 FV.
Bit 14: HART bus busy (slave in burst or
other master present)

Bit 15: HTM Task not running (option not
available).

Note: Bit 1-3 is set when Invalid
Measurement of Slave 1 Non PV, i.e. all
three bits are set simultaneously.

Slave 1 PV

2202

Primary variable from slave 1
represented in IEEE 754 format, using
Floating Point Format Code 3.

Slave 1 SV

2204

Secondary variable from slave 1
represented in IEEE 754 format, using
Floating Point Format Code 3.

Slave 1 TV

2206

Tertiary variable from slave 1
represented in IEEE 754 format, using
Floating Point Format Code 3.

Slave 1 FV (QV)

2208

Fourth variable from slave 1 represented
in IEEE 754 format, using Floating Point
Format Code 3.
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Table 1-17. Measurement units and
corresponding input registers

Table 1-18. Conversion of Unit
Code to Measurement Unit

Measurement Units

Measurement units for the various HART slaves are stored in input registers
as a Unit Code presented in Table 1-17. Conversion from Unit Code to
measurement unit is given in Table 1-18 on page 1-29.

Register Name

Register Number

Note

Slave 1 PV Units

104

Slave 1 SV Units 108
Slave 1 TV Units 112
Slave 1 FV (QV) Units | 116

See Table 1-18 for conversion from Unit
Code to Measurement Unit.

Unit Code ‘ Measurement Unit Unit Code Measurement Unit

Volume Length

40 US Gallon 44 Feet

41 Liters 45 Meters

42 Imperial Gallons 47 Inches

43 Cubic Meters 48 Centimeters

46 Barrels 49 Millimeters

111 Cubic Yards Temperature

112 Cubic Feet 33 Degree Fahrenheit

113 Cubic Inches 32 Degree Celsius
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SPECIFIC MODBUS
HOST CONFIGURATION

The Remote Terminal Unit needs to be configured to communicate and
correctly interpret data when reading input registers from the Rosemount
5300/5400 transmitter.

Baud Rate

The specified Baud Rates below are recommendations. If other Baud Rates
are used, make sure that the 5300/5400 and the RTU are configured for the
same communication speed.

Floating Point Format Code

See Section “Common Modbus Host Configuration” on page 1-25.

RTU Data Type

The RTU Data Type specifies which configuration to use in the RTU in order
for the RTU to correctly interpret a floating point number transmitted from the
5300/5400 transmitter with Modbus.

Input Register Base Number

Data registers in the 5300/5400 transmitter with Modbus are numbered
exactly as they are transmitted in the Modbus communication. Some RTUs
use different naming conventions and to configure the RTU to poll the correct
registers from the 5300/5400 Modbus, an Input Register Base Number is
stated for each RTU respectively. E.g. if the input register base number is 1
for the RTU, the 5300/5400 Modbus input register 1302 has to be entered in
the RTU address as input register 1303.

Emerson Process Management

ROCB800 Series

Figure 1-9. Wiring Diagram for
Connecting 5300/5400 Modbus to
Emerson Process Management

ROC800 Series

Table 1-19. Parameter Values (in
case of Emerson Process
Management ROCB800 Series)

1-30

ROCB800 Series
5300/5400 Modbus RS-485
MA A (RX/TX+)
MB B (RX/TX-)
POWER + %
POWER - _| z
COM
Power Supply
+ 8 to + 30 Vdc
(max. rating)
GND
Parameter Value
Baud Rate 9600
Floating Point Format Code 0
RTU Data Type Conversion Code 66
Input Register Base Number 0

The Input Register Base Number needs to be added to the Input Register
address of the 5300/5400 transmitter. In this case, register 1300 needs to
have 1300 entered as the address.
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Emerson Process Management

FloBoss 107
Figure 1-10. Wiring Diagram for
Connecting 5300/5400 Modbus to FloBoss 107
Emerson Process Management 5300/5400 Modbus RS-485
FloBoss 107 MA A
MB B
POWER + NC
POWER - _| NC
PWR
Power Supply GND
+ 8 to + 30 Vdc
(max. rating)
GND

Table 1-20. Parameter Values (in

case of Emerson Process B Value
Management FloBoss 107)
Baud Rate 9600
Floating Point Format Code 0
RTU Data Type Conversion Code 66
Input Register Base Number 0

The Input Register Base Number needs to be added to the Input Register
address of the 5300/5400 transmitter. In this case, register 1300 needs to
have 1300 entered as the address.

ABB TotalFlow

Figure 1-11. Wiring diagram for

connecting 5300/5400 Modbus to 5300/5400 Modbus TOTALFLOW
ABB TotalFlow
COMM 1/2
POWER + 1 VBAT
POWER - 2 GND
MA - 3
4
MB |_ 5
6 Bus -
7
8 Bus +
9
Table 1-21. Parameter Values (in
case of ABB TotalFlow) PRrEmEED Value
Baud Rate 9600
Floating Point Format Code 0
RTU Data Type 16 Bit Modicon
Input Register Base Number 1

The Input Register Base Number needs to be added to the Input Register
address of the 5300/5400 transmitter. In this case, register 1302 needs to
have 1303 entered as the address etc.
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Thermo Electron Autopilot

Figure 1-12. Wiring Diagram for

Connecting 5300/5400 Modbus to AutoPILOT
Thermo Electron Autopilot 5300/5400 Modbus CEB TB1
MA 1RX+
MB 2RX-
POWER + —|
POWER -

Power Supply
+ 8 to + 30 Vdc
(max. rating)

GND
Table 1-22. Parameter Values (in
case of Thermo Electron Autopilot) PErEmEED Value
Baud Rate 9600
Floating Point Format Code 1
RTU Data Type IEEE Flt 2R
Input Register Base Number 0

The Input Register Base Number needs to be added to the Input Register
address of the 5300/5400 transmitter. In this case, register 1302 needs to
have 1302 entered as the address etc.

Bristol ControlWave Micro

Figure 1-13. Wiring Diagram for

Connecting 5300/5400 Modbus to ControlWave Micro
Bristol ControlWave Micro 5300/5400 Modbus Com Port 3 (C3) RS-485
MA
MB 1
POWER + 6
POWER - ] 2 7
TXD- 3 8
TXD+ 4
Power Supply oND 5 9
+ 8 to + 30 Vdc
(max. rating)
GND DB9 Male
Table 1-23. Parameter Values (in
case of Bristol ControlWave Micro) e Value
Baud Rate 9600
Floating Point Format Code 2 (FC4)
RTU Data Type 32-bit registers as 2 16-bit registers
Input Register Base Number 1

The Input Register Base Number needs to be added to the Input Register
address of the 5300/5400 transmitter. In this case, register 1302 needs to
have 1303 entered as the address etc.
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ScadaPack

Figure 1-14. Wiring Diagram for
Connecting 5300/5400 Modbus to
SCADAPack 32

Table 1-24. Parameter Values (in
case of SCADAPack 32)

Kimray DACC 2000/3000

Table 1-25. Kimray Input Types and

Corresponding Values

SCADAPack32
RS-485 on COM1
MA 2 RX-
MB 3TX-
POWER + 4 GND
POWER - 5 RX+
6 TX+
7 Not Used
Power Supply 8 Not Used
+ 8 to + 30 Vdc
(max. rating)
REF
Parameter Value
Baud Rate 9600
Floating Point Format Code 0

RTU Data Type

Floating Point

Input Register Base Number

30001

The Input Register Base Number needs to be added to the Input Register
address of the 5300/5400 transmitter. In this case, register 1302 needs to

have 31303 entered as the address etc.

This table shows input types in Kimray IMI software and the corresponding

value. The communication port must be configured to use “Tank Levels”

protocol.

Kimray Inp type

5300/5400 variable

Format

Tank Levell

PV

ddd.dd.alt. -dd.dd

Tank Level2

SV

ddd.dd.alt -dd.dd
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TROUBLESHOOTING

1-34

No communication on RS-485 bus (MA, MB)

Check that the cables are connected

Check that PWR+ is connected to + and PWR- is connected to - on the
power supply

Make sure the 5300/5400 transmitter is supplied with 8-30 Vdc
(max. rating)

Try alternating MA/MB if you are unsure of the polarity

If an RS-485 converter is used, make sure it is properly installed and
configured

The last 5300/5400 transmitter may need a terminating 120-Q resistor
connected between MA and MB

No 5300/5400 communication in RRM

Using HART+, HART-

« HART modem is not properly connected

* Polling address is incorrect in RRM (default 1)
Using MA, MB

* See No communication on RS-485 bus

* Polling address is incorrect in RRM (default 1)

* Cycle the power and wait 20 seconds before polling

No communication with Modbus RTU protocol

See No communication on RS-485 bus

Make sure the “Modbus Communication Protocol Configuration” is
done properly

Make sure the Modbus RTU address is unique on the bus
Cycle the power and try to connect
Check the RTU communication settings

No communication with Modbus ASCII protocol

See No communication on RS-485 bus

Make sure the “Modbus Communication Protocol Configuration” is
done properly

Make sure the Modbus ASCII address is unique on the bus
Cycle the power, waiting 40 seconds before communication begins
Check the RTU communication settings

No communication with Levelmaster protocol

See No communication on RS-485 bus

Make sure the “Modbus Communication Protocol Configuration” is
done properly

Make sure the Levelmaster address is unique on the bus
Cycle the power, waiting 40 seconds before communication begins
Check the RTU communication settings
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HMC FIRMWARE
UPGRADE IN
ROSEMOUNT RADAR
MASTER

The HMC's firmware is upgraded using Rosemount Radar Master (RRM). A
detailed description on how to carry out the firmware upgrade is shown on the
following pages.

NOTE

All settings in the HMC will be lost after upgrading the transmitter.
Reconfiguration of Modbus communication setup and alarm handling is
required after completing the upgrade.

NOTE

During firmware upgrade, the HMC Modbus RTU address must be 246, the
default address. Make sure to disconnect other Modbus RTU devices that are
connected and have address 246.

NOTE
Do not interrupt communication between the PC and the 5300/5400 level
transmitter during the firmware upload.

1. Start RRM and select Communication Preferences in the View menu.
2. Navigate to the Modbus tab and use the following settings:

* Modem: RS-485

e Baudrate: According to configuration in HMC (default 9600)

» Stop Bits: According to configuration in HMC (default 1)

» Parity: According to configuration in HMC (default None)

* Handshake: RTS/CTS

e Response Timeout: 1000 ms

* Retries: 3
3. Select Enable Modbus Communication and click OK.

8. Search Device rz|
Pratacalls] Modbus 57 Settings... | << Basic |
—Select Scan Type
" Scan Al Addresses
—{* ScanAddress Range
Start Address End Adddress
[ 245 [ 245

— Select Device

Device Type | Verszion Protocol Address

Start Scan Cancel Help

Scan completed..ﬁ device[s) faund.
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4. If the HMC is configured for Modbus ASCII or Levelmaster
communication cycle the power to the transmitter (the HMC will then
communicate using Modbus RTU for 20 seconds and under that time it is
possible to connect with RRM).

5. Open the Search Device window and make sure Modbus is selected in
the Protocol list.

®. Search Device |z|

Protocols] IModbus LI Settings... | <« Basic |

—Select Scan Type
" Sean All Addresses

{* Scan Address Range

Start Address End Adddress
| 245 245

— Select Device

Mame Device Type | Werszion Protocol Address Unit I
UntitledT [1c2 [ Madbus G

Start Scan | Stop Scan | QK | Cancel |

Scan completed. 1 device(z] found Select device and press QK to connect.

6. Search for HMCs by selecting “Scan Address Range”, and choose a
start and end address for Modbus. The default HMC Modbus address is

246.
7. Click the Start Scan button.
8. Click OK to connect when the device is found.
9. From the Service menu, choose the Enter Service Mode option.

Password

Ixxxx>1

Submit | Cloze | Help |

10. Type password, “admin”.
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11. From the Service menu, choose the Upload Firmware option.

173 Upload Firmware - [Untitled1] 3

Select Cry File to Upload
Filename

Device Configuration Hazard
] Browse...

Diuring uploading of new firmware the

device output will not be controlled by IREhi=s
the device measurement and after 3
uploading the device may change

beharviour.

Make sure spstems and people relying
ot data from the device are made
aware of the changed conditions due to
this action.

Failure to do g0 could result in death,
zerious injury and/or property damage

Cloze Help

12. Click Browse.

Select Cry File

Look in: |23 1C2.1 - emcoimE-

é () goofy

k! IC5) Testrasulks

My Recent ) Tiny

Documerts |E] hmc_appl_1C2_1.cry
(L

Desktop

My Documents

My Computer

File name: |hmc:_app|_1 CZ_1.cy j Open |
My Network  Files of type: |EF|Y Files [*.cry) j Cancel
Flaces

™ Open as read-only

13. Select the upgrade “.cry” file.
14. Click Open.
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13 Upload Firmware - [Untitled1]

Select Cry File to Upload
Filename

Device Configuration Hazard

Diuring uploading of new firmware the Eictifizs
device output will not be controlled by

the device measurement and after ’—3
uploading the device may change
beharviour.

Make sure spstems and people relying
ot data from the device are made
aware of the changed conditions due to
this action.

Failure to do g0 could result in death,
zerious injury and/or property damage

Upload | |

|E:\temp\1 CZ2_1%hme_appl 1C2_1.cry

Cloze | Help

15. Click the Upload button to start the firmware upgrade.
16. When upload is finished, select Diagnostics in the Tools menu.

[ Rosemount Radar Master - [Untitled?] - [Diagnostics - [Untitled2]]

g Device View Setup Tools Service Window Help

QUSSR G ¥ B 0 30

Device Explorer x| _g Diagnostics
. Device List % Device Status

Le8 LT-01[5400 102]
L% LT-5300 (5300 008 ]
Lee | T-83[ 5400 102]
L Offine [ 5300 0C4 ]
ﬁ OffiineFF [ 5300 0C4 ]
PROOfne [ PRO 26t
1 Untitled! [HMC 102]
[#g Untitled2 [ HMC 1.

/W Device Warnings

- Databaze [HREG] Emor

- Checksum Checksum

-Wersion

17. Click Device Errors and check for “Checksum”.
18. Ifitis on the list, choose the Factory Settings option from the Tools

menu.

X, Reset to Factory Settings

Select areas to reset

[evice Configuration Hazard

when resetting to Factory D efault " Specified
values your configuration changes

will be lost and the device may
change behaviour.

Make sure systems and people
relying on data from the device are
made aware of the changed
conditions due to this action.

Failure to do so could result in
death, zerious injury and/or
property damage

v APPID_FRMFACTSET_Modbus

v APPID_FRMFACTSET_Harth aster
v APPID_FRMFACTSET _MiscChl
J_FRiby

QK Cancel Help
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19. Select All and click OK.

Reset to Factory Settings

\.\.’/ Are you sure you wank ko Reset to Factary Settings?

Yes Mo Cancel |

20. Select “Yes”.

NOTE

An error message might be displayed when performing the Reset to Factory
Settings operation. The operation has been successful if the checksum error
has been cleared.

21. Select Restart in the Tools menu to restart the HMC.

22. The checksum error should no longer be present (select Diagnostics in
the Tools menu to verify, see Step 16). If it still persists, follow the next
steps.

23. Select View Holding Registers in the Service menu and write the value
16760 to register 65510.

_? View Holding Registers Q@E—
Search Registersby———————— Show values in
7 Mames & Humbers @ Dec  { Hex
Start Register
| EE510 Mumber of ¥alues
I
el

[Mumber [ identifier |urits
65510 | Undefined 16760 ina

Fiead | Stare | Cloze Help

24. Restart the HMC.

25. If the HMC is configured for Modbus ASCII or Levelmaster
communication after upload has been completed, proceed with the
following:

1. Close RRM and disconnect the RS-485 converter from the HMC.

2. Cycle the power to the HMC to have it exit Modbus RTU
communication mode.
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SPECIFICATIONS

Table 1-26. Specifications

Power supply

8-30 Vdc (max. rating)

Power consumption

< 0.5 W (with HART address=1)
< 1.2 W (incl. four HART slaves)

Signal wiring

Two-wire half duplex RS-485 Modbus. Use shielded
twisted pair wiring, preferably with an impedance of 120Q
(typically 24 AWG), in order to comply with EIA-485
standard and EMC regulations.

Power supply cabling

The power supply cables must be suitable for the supply
voltage and ambient temperature, and approved for use
in hazardous areas, where applicable.

voltage limit

Ground (common mode)

7V

Bus termination

Standard RS-485 bus termination per EIA-485

See the Rosemount 5300 Series Reference Manual (Document No.
00809-0100-4530), and the Rosemount 5400 Series Reference Manual
(Document No. 00809-0100-4026) for further specifications.
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